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This Process Document describes the steps to design a grassed waterway in WDT, using a ground surface derived 
from either a LiDAR DEM or a GPS topography survey, and hydrology data derived from NRCS GIS Engineering Tools 
(the “Minnesota Tool”). 
 

1. Run the GIS Engineering Tools Watershed Tool (and RCN tool, if desired) 
a. Refer to Share Point for the Indiana User Guide, instructions on loading the toolbox, and Iowa video links 

2. Set WDT Preferences 
 

Edit/Preferences > Waterway Design  
 

 
 
Channels: Set Default Channel Shape as desired    
 
Set shape parameters for each shape: 

 
 

 

https://ems-team.usda.gov/sites/NRCS_Nebraska/engineering/Technology/Software/GIS/Indiana%20NRCS%20Engineering%20Tools%20Guide%20v1.11.pdf
https://ems-team.usda.gov/sites/NRCS_Nebraska/engineering/Technology/Software/GIS/MN%20Tool%20Installation%20Instructions.pdf
https://ems-team.usda.gov/sites/NRCS_Nebraska/engineering/Technology/Lists/Video%20Links/AllItems.aspx
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Refer to the EFH Chapter 
7 Amendment, found in 
Section IV of the eFOTG 
under the 412 practice 
standard, for soil 
erodibility categories 

Ignore Construction Checkout Report (use ENG-21T or ENG-21P for checkout). 
 
Soils – Use “Enter Stress” and choose most common Allowable Stress category: 

 
 
Vegetal: Set Stability & Capacity Retardance Classes (no need to set stem length/density) 
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Apply each time, [OK] and export to personal .properties file. 
 

3. Create new customer, new project, new waterway design 
4. Create a ground surface to use for design 

 
a. Import an XYZ .csv GPS survey and add breaklines, if needed. 

– OR –  
b. Import a LiDAR DEM 

i. Refer to Share Point Nebraska Process Guide – Creating a LiDAR DEM and Imagery for use in EFT 
c. Import imagery, if desired (highly recommended!). The process guide explains how to do so. 
d. Save the waterway design – (Ctrl-S)! 

 
5. Create waterway centerline alignment 

 
a. Click [New] button next to “Alignments” design elements box 

 

 
 

b. Type a name for the WW (avoid spaces/special characters). 
c. Click [Sketch Alignment] 
d. “Sketch operation will delete all existing stations… OK to proceed?” Click [OK] 
e. Move mouse pointer over to map.  Use mouse wheel to zoom in/out, hold pointer near edges of view 

to slowly pan the view (aggravating slowly… be patient before clicking a vertex). 
f. Click each desired vertex, beginning at Upstream end (patience with panning/zooming). 
g. Make SURE the screen/view isn’t moving anymore, then double-click the last vertex. 
h. There’s a minor bug in WDT right now where a duplicate point is created upon the double-click. 

i. Review the vertex table, scroll to the last vertex; if there are two sets of the same coordinates, 
<right-click> “Delete Alignment Station” to delete the last row. 

 
i. Click [Apply Curves]. 
j. Click [Move Points] to massage vertices and radii of the alignment until it lays in where desired. 

i. Again, practice extreme patience with the mouse pointer, holding it near the edge of the view to 
pan. 

 

https://ems-team.usda.gov/sites/NRCS_Nebraska/engineering/Technology/Software/GIS/Nebraska%20Process%20Guide%20-%20ArcGIS%20-%20Creating%20a%20LiDAR%20DEM%20and%20Imagery%20for%20use%20in%20EFT.pdf


 Step-by-Step Grassed Waterway Design with WDT v 6-2016 
 Nebraska NRCS 
 

Page 4 of 14 
 

k. Once alignment looks satisfactory, click [Move Points] again to toggle off. 
 

 
 

l. [Accept Edit] 
m. Save the waterway design – (Ctrl-S)! 

 
6. Design Waterway 

 
a. Click [New] button next to “Waterways” design elements box. 

 

 
 

b. Type a name for the WW (avoid spaces/special characters). 
c. Select the alignment to be used for this design. 

 

 
 

d. Don’t set a seeding width.  Right now, the top width out to the daylight edges of the waterway is 
used (because of side dikes pretty much).  Seeding width will be added to this width (which is too 
wide). 

e. Set a benchmark if one is being used. 
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f. Click the “Hydrology” tab and enter EFH-2 hydrology information. 
i. Use the EFT Map “Measure Area” button to measure drainage area if it’s not known yet (no 

Watershed Tool run, GPS survey, etc.) 
g. Click [Simulate] to calculate a peak Q. 
h. Set initial Q fraction, if desired. 

i. This is a nice option, but it should be used with caution.  Don’t just pick some arbitrary value. 
ii. The % value used is the percentage of the watershed that is upstream of the first station of the 

waterway. 
iii. I.E. if a waterway is very long and travels a long ways up the flow length of the watershed, maybe 

only 60% of the watershed actually drains to the first station of the waterway.  The rest 
progressively drains into reaches farther down the waterway. 

iv. Need to actually measure the watershed area above station 0+00 of the waterway alignment. 
v. For a conservative design, use 100%, which will apply the same peak Q to every reach. 

i. Click the “Channel” tab. 
i. Channel Shape will default to the preference setting – change as desired. 

 
 

ii. In the Parabolic channel controls, the limiting slope value ensures that a warning is generated if 
the sideslopes of a parabolic waterway are steeper than that.  It usually doesn’t trigger for normal 
designs, but could if a fixed depth is used. 

iii. Channel ends – the values used here will tell WDT to bring the channel up to original ground over 
the distance used.  It’s mostly meant to help generate additional yardage, but helps “finish” up the 
ends graphically to ensure a waterway will fit where you want it, too.  It DOES NOT find original 
ground “on grade” from the last station to original ground.  But it’s not included in a stakeout or 
checkout report/file either. 
 
From EFT Help: 
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j. Click the “Profile” tab. 
i. At this point, it’s advisable to either minimize the EFT Map or move it to a second monitor, which 

will help the readability of the profile. 
ii. Click [View Controls] and click “Show Left/Right Banks”.  Set the Low Bank Offset value so that it 

will show where approximately the top edge of an anticipated waterway top width would be (i.e. if 
you have an idea that you’ll need a 20’ bottom width and 1.5’ deep, set the offset value to about 
40’). 
 

 
 

iii. <Right-Click> anywhere over the profile grid, and click “Generate Channel Bottom”. 
 

 
 

iv. Enter desired Min/Max Stations, station interval, cut depth; click [OK]. 
1. Recommend setting starting station at the same distance as the “Start Grade length”, if used.  

This will ensure a cut sheet has stationing that begins with station 0+00 at an original ground 
daylight location. 

2. Remember the smaller the station interval, the more reaches you have to deal with.  Try to use 
an interval that makes life easier (recommend starting with 300’).  You can always add 
additional vertices afterward. 

3. Have an idea of the bed slope that will lay in along the profile, anticipate a design flow depth, 
and start with a centerline cut that will create that flow depth plus freeboard within the 
left/right banks. 

v. Review the generated profile to decide if additional vertices are required or if any need to be 
raised/lowered.  Recommend editing the Channel Z’s in the profile table to even tenth elevations.  
Round the stations off, too, if desired.  But if you do that, the Channel Z’s will need to be changed 
to maintain desired cuts. 
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vi. Click the “Soil/Vegetal” tab and review/edit the Soil/Vegetal settings if needed. 
1. Maybe the soil is different than the preference settings (.030 instead of 0.050).  Simply double-

click the first row in the Soil/Vegetal table to open up the Soil/Vegetal Parameters interface. 
2. Change the erodibility value in the “Soil Parameters” tab, then click the “Apply to Reaches” 

tab. 
3. Make sure the first row is selected, then drag the slider bar all the way to the bottom of the 

list, then hold the <Shift> key while selecting the last row, which will select all rows in the 
table. 

 

 
 

 
 
4. Click [OK] to apply the changes. 
5. Repeat for any changes to the vegetal parameters, if needed.  Maybe you want to use Brome 

instead of a mix.  In that case, you’ll need to change the vegetal cover factor from 0.75 to 0.87. 
Likewise, maybe a C/D design instead of a B/D design. Same deal. 

 
k. Click the “Design” tab. 
l. Notice that the Channel table has ‘0.00’ values throughout, and the status for each row says “Re-run 

simulation”. 
m. Click [Simulate Runoff] to generate an initial design.  DO NOT click [Design Channel] yet. 
n. A “Reach Sim Results” tab/page will pop up, with the first reach highlighted in the table. 

i. Click each vertex to see the simulation results for it.  Some reaches will have a green checkmark, 
others may have warnings. 

ii. A common warning is that the channel velocity under Capacity Flow Conditions is less than 1.5 
ft/sec. If it’s really close, a simple fix is to steepen the reach just slightly by lowering/raising one 
end. 

iii. Close the Reach Sim Results page at any time.  Get it back by simply clicking a reach in the table. 
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o. Set the Top Width to be used over the length of a parabolic waterway. 
i. Notice that a parabolic design will set Depth+FB and Top Width values that put the effective soil 

stress right at the allowable stress value.  Thus the depths and top widths will vary in each reach. 
ii. Note the widest top width in the table. 

iii. <Right-Click> any column heading in the “Design” tab channel table. 
 

 
 

iv. Click “Set Fixed Width…”and enter an even value just larger than the widest top width noted. 
 

 
 

v. Click [OK] 
vi. Click [Simulate] again. 

vii. Review the “Reach Sim Results” for each reach.  Note that now the effective soil stress values differ 
and vary. 

viii. Make sure there are no reach warnings about exceeding the allowable soil stress. 
ix. So, a final parabolic design with a uniform top width will have varying depths, although the depths 

will usually be within hundredths of each other if the bed slopes are uniform.  Flatter or steeper 
reaches may require a little wider or narrower top widths to maintain a more-or-less-the-same 
depth.  Experiment to get a good uniform design. 

p. Set the Bottom Width to be used over the length of a trapezoidal waterway. 
i. Notice that a parabolic design will set Depth+FB and Bed Width values that put the effective soil 

stress right at the allowable stress value.  Thus the depths and top widths will vary in each reach. 
ii. Note the widest bottom width in the table. 

iii. Unlike a parabolic design, <Right-Click>, “Set Fixed…” isn’t the desired action for a trapezoidal 
design.  Remember, “Set Fixed Width…” sets the top width at design flow depth. We want a fixed 
bottom width. 

iv. Go back to the “Channel” tab and set the “Min Bed Width” value to an even value just larger than 
the widest bed width noted. 

v. Switch back to the “Design” tab and click [Simulate] again. Bed width will be the same for every 
reach. 

vi. Review the “Reach Sim Results” for each reach.  Note that now the effective soil stress values differ 
and vary. 

vii. Make sure there are no reach warnings about exceeding the allowable soil stress. 
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viii. So, a final trapezoidal design with a uniform bed width will have varying depths, but if the largest 
bed width is used for every reach, shallower depths don’t matter.  Just make sure the channel 
velocities don’t get too low under capacity flow conditions. 
 

q. A special NOTE ON DEPTH: If a deeper channel is desired, DO NOT set a Fixed Depth value.  When you 
set a fixed depth, it uses that depth for CAPACITY FLOW CONDITIONS, ignores a minimum bed width 
or top width value, and ends up causing soil stress to be too great during stability flow conditions.  If 
you want an overall channel depth greater than the designed capacity flow depth, set a freeboard 
value in the channel tab that gives the desired depth, then use the deepest Depth+FB value as the 
minimum depth to construct the waterway.  The CONSTRUCTED waterway can always be deeper than 
the required design flow depth. 
 

r. At this point, you have a successful waterway design; basically with a waterway wizard run for each 
reach of the waterway.  The difference is that you have documented real-world reach slopes for the 
length of the waterway.  Even if you don’t [Design Channel], the design is valid. 

 
s. NOW you can design the channel, which will calculate earthwork, provide for the ability to evaluate 

construction extents, and see cross-sections. 
t. But first, expand the EFT Map if you collapsed it earlier. 
u. Click [Design Channel]. 
v. The waterway surface will appear on the EFT Map. 
w. Change the color & linewidth of the waterway to make it easier to review and print on an aerial 

image. (Optional) 
i. <Right-Click> “Structure” under the waterway name in the EFT Map TOC. 

ii. Click “Layer Properties” 

 
 

iii. Change the linewidth and color to something helpful. 

                                  
 

x. Zoom in and pan around using the EFT Map controls, looking over the cut/fill extents of the waterway 
surface and for any areas where side dikes were created. 

y. Go back to the “Profile” tab. <Right-Click> anywhere on the profile grid, click “Cross Section”, and click 
on the grid again at a station where you’d like to review a cross-section. 
i. Set the Increment up/down with the arrows, and advance stations with the station arrows to 

review cross-sections at any point along the alignment. 
z. The combination of the plan view and the cross-sections will help review if any tweaks need to be 

made to the alignment to avoid excessive fill through low areas to maintain depth or to avoid the 
creation of side dikes. 
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aa. Use the [View Controls] button while in the cross-section view to tweak the buffer width so that the 
cross-section fills the grid, if desired.  You can also change the vertical scale factor, if desired. 
This cross-section uses the preference settings of a 50’ buffer and vertical scale of 2: 

 
 
This one uses a 10’ buffer and no vertical exaggeration (Vert. scale factor of 1): 

 
 

bb. If you’d like to include one or more cross-sections in the construction reports, just click the “Include in 
Report” box in the lower right corner of the cross-section window to add the desired cross-section. 

cc. Close the Cross Section tab at any time. 
dd. To review which cross-sections will be included in reports, <Right-Click> anywhere on the profile grid 

and you’ll see an “Open Cross-Section…” option that lists the stations selected.  To clear all cross-
sections from the list, just click “Clear Cross-Sections” 

 
 

ee. [Accept Edit] to finalize the design. 
ff. Save the waterway design – (Ctrl-S)! 
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7. Tweak Waterway Design (if needed) 
a. If changes to the alignment are warranted, select the alignment name in the “Alignments” design 

elements box and click [Open] (or double-click the alignment name). 
b. Repeat the [Move Points] process to slide the alignment over as needed. 
c. [Accept Edit] 
d. The waterway design will show a caution symbol now because the alignment changed. 
e. Select the waterway name in the “Waterways” design elements box and click [Open] (or double-click 

the waterway name). 
f. Go to the “Design” tab. 
g. [Simulate] again, review the design for any issues. Tweak vertex elevations and top/bottom widths as 

needed (see previous steps). 
h. [Design Channel] 
i. Review the waterway surface in the EFT Map 
j. Repeat until satisfied with the design, [Accept Edit] and SAVE IT! 

Note: If you forget to design the channel before accepting edit, the waterway surface will disappear.  
Don’t panic.  Just go back in and design to get it back. 

 
8. Create Additional Alignments and Waterways As Needed 

a. If you’re designing a waterway that drains into another waterway, there’s a handy way to get the end 
station elevation of one to match up with the desired station of the other. 

i. Be sure the alignment for the contributing waterway ends close to or crosses the desired 
station of the receiving waterway. 

ii. Make sure the receiving waterway is designed. 
iii. Create the profile for the contributing waterway. 
iv. In the profile points table, <Right-Click> the last station and choose “Match Vertex”. 

 
v. All vertices within 50 feet of the station will appear in a list of “nearby profile points”. 

vi. CLICK the desired station so that it’s highlighted, and click [OK]. 
vii. The channel Z will update to match the elevation of the receiving waterway station. 

b. Now, just be sure the following requirement of the 412 standard is met: “The capacity of the 
waterway must be large enough so that the water surface of the waterway, at design capacity, is 
below the water surface of the tributary channel, terrace, or diversion that flows into the waterway at 
design flow.” 

 
9. Print Waterway Documentation and Cut Sheet Reports 

a. Edit the Report Title Block “Name” field so something more explanatory; EFT automatically populates 
based on customer/project/design names. 

b. SAVE THE DESIGN! 
c. Click “File” in the top menu. 
d. Click “Print Reports” 
e. Check the “Waterways Reports” box. 
f. Select the waterway(s) to be printed. 
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g. Check “Waterway Profile Report”, “Cross-Section Report” (if desired), “Documentation Report” and 
“Cut-Sheet Report” boxes. Set cut-sheet sample interval to “0”. 
 

 
 

h. Click [Finish] 
i. Click [OK] 
j. Wait for the progress window to finish, then either [Open] or [Save] the reports to a folder on your 

computer. 
k. Print the reports. 
l. If opened in WDT, close the Report Preview screen. 

 
10. Complete the front side of the NE-ENG-21T or ENG-21P 

a. The jobsheets are available on the eFOTG and are fillable. 
b. Save somewhere on your workstation, and when checkout is complete, the checkout data section can 

be filled out and the form will do the math for you for certification. 
 

11. Create a plan view of the project for inclusion in the construction packet 
a. Use the “Zoom Extents” or “Pan” button to zoom out to see the entire project. 
b. Check on/off any layers you do/don’t want to see on the plan view. 
c. Recommend to turn off the following information: 

i. Surveys (everything) 
ii. GPS ground surface triangles/breaklines 

iii. Sheet data grid 
iv. Drainage area drawings 
v. Alignment points (the blue PI’s and radius points). 

d. <Right-Click> “Sheet Data” in the EFT Map TOC. Click “New Map Sheet” 

 
 

e. Enter information as desired, like so (recommend no legend or bar scale – they’re not worth much): 

  Print scale is a shot in the dark. No worries you can edit after. 
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f. Click anywhere on the map screen to place a map sheet boundary. 
g. <Right-Click> the sheet name in the EFT Map TOC. Click “Edit Params”. 

 

 
 

h. Change the scale as desired. 
i. Repeat <Right-Click>, click “Move Sheet”, and click-and-hold to move the sheet border. 
j. Finally, <Right-Click> again and click “Save Map-Layer Config”.  This preserves the on/off settings of 

layers for that sheet. 
k. You can create multiple map sheets (with different names, of course) that display other layer 

information, if desired.  Just remember to turn layers on/off and “Save Map-Layer Config” for each. 
l. SAVE THE WATERWAY DESIGN! 
m. After creating a map sheet, then turning all layers back on, you can just <Right-Click>, click “Restore 

Map-Layer Config”, and the layers will turn on/off to the settings for that map sheet.  It’s quite handy. 
n. Print the Map Sheet using “File” > “Print Reports”. 
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12. Create a file of stake out points 
a. “File” > “Export >” > “Points File” 

 
b. Select applicable waterways and set interval between as desired, but recommend setting to “1000” so it 

only exports points at the designed profile vertices. 

 
 

c. [OK] 
 
d. Station Points Generation popup will tell you where the .csv file was saved.  It puts a {waterwayname}.csv 

file in the C:\Users\{firstname.lastname}\My EFT Files\.eft\{customer}\{project}\{design} folder.  You have 
to go hunt for it. 

 
 

e. WDT exports bottom edge points and daylight points at each station for trapezoidal waterways.  
Recommend only staking out bottom edges. 

f. WDT exports centerline bottom as well as top edge points.  Your choice if you want to stake top edge 
showing areas where fill is needed to keep flow depth. 

g. Refer to the Share Point document “GPS_Terrace_Alignment_Points_Export_and_Upload…docx” dated 
April 1, 2014 (in the TDT folder) for instructions on how to process the stake points file and load it into a 
data collector. 

 
IMPORTANT: If a LiDAR DEM design is completed and needs to be staked out, GPS control points MUST be OPUS-
corrected and proper ground-truthing MUST occur to ensure correct locations/cuts are staked!!!!  Ask for training 
from your Area Engineer or Area CET. 


